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ABSTRACT 

 An earthquake is an unpredictable natural phenomenon which happens suddenly and cannot stop it but can be 

alerted from it. Vibration sensor is used to detect the pre-earthquake vibrations. When the vibrations occur, 

accelerometer senses and converts them into equivalent ADC values.  

 Then these digital values are read by microcontroller Arduino. Then Arduino compares these values with 

threshold value that is already predefined. If Arduino finds the sample value is greater than the threshold value, then 

Arduino trigger the buzzer and displays a message showing the status of alert over the 16x2 LCD and a LED also 

turned on.  

 Using GSM module, the SMS alert message is sent to the respective registered mobile number. Also two other 

sensors are used, for detecting fire and any gas leakage in the building can be sensed using flame and gas sensor 

respectively. If detected SMS alert is sent to the corresponding registered mobile numbers. 
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1 INTRODUCTION 

 An earthquake is the shaking of the surface of 

the Earth resulting from a sudden release of energy in 

the Earth's lithosphere that creates seismic waves. This 

release of energy typically occurs when stress builds up 

along fault lines (cracks in the Earth's crust), causing 

the rocks to break or slip. 

 When the rocks move, the energy travels 

through the Earth as seismic waves, which we feel as 

ground shaking. Earthquakes can vary in size, from 

minor tremors that are barely noticeable to large quakes 

that can cause significant destruction. 

 They usually occur along plate boundaries, but 

can also happen within the interior of tectonic plates. 

The magnitude of an earthquake is measured on the 

Richter scale, and its effects can be destructive 

depending on factors like its strength, depth, and 

proximity to populated areas. 

1.1 Seismic Waves: 

 1.1.1. Primary Waves (P-waves): P-waves are 

the fastest seismic waves, traveling at speeds of around 

5 to 8 km/s (depending on the medium they travel 

through).These waves move in a compression-

expansion motion, similar to sound waves. The 

particles of the material (rock, soil, etc.) move back and 

forth in the direction of wave propagation.P-waves can 

travel through both solids and liquids. This is why they 

are the first waves to be detected by seismic 

instruments. 

 

• They cause the ground to move in a back-

and-forth motion (compression and 

decompression). 

• P-waves are the first to be recorded by 

seismographs because they are the fastest. 

 

1.1.2. Secondary Waves (S-waves): S-waves are 

slower than P-waves, traveling at speeds of about 3 to 5 

km/s.S-waves move the ground in an up-and-down or 

side-to-side motion, perpendicular to the direction of 

wave travel. This is why they are also called shear 

waves.S-waves can only travel through solids. They 

cannot move through liquids, which is why they don't 

appear in data from seismic stations that are located in 

areas with liquid layers, like Earth's outer core. 

 

• S-waves cause the ground to shake side to 

side or in a vertical motion. 

• S-waves are slower than P-waves and, 

therefore, are the second waves to be 

detected. 
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1.1.3. Surface Waves: Surface waves are slower than 

both P-waves and S-waves, typically traveling at speeds 

of about 2 to 4 km/s.These waves travel along the 

Earth's surface and move in a rolling or side-to-side 

motion, which causes the most damage during an 

earthquake. 

1.2 The Importance of Early Detection: 

 Saving Lives: Early detection can provide 

critical seconds or minutes to warn people, allowing 

them to take protective actions such as dropping to the 

ground, taking cover, and holding on. This can prevent 

injuries and fatalities, especially in densely populated 

areas. 

 Minimizing Damage: With early warning 

systems in place, infrastructure like buildings, bridges, 

and roads can be prepared or temporarily shut down. 

Power grids, gas lines, and factories can be turned off to 

reduce the risk of fires or explosions. This can 

significantly reduce the physical and economic damage 

caused by an earthquake. 

 Public Safety: Early warnings allow for the 

evacuation of vulnerable areas or the suspension of 

dangerous activities (e.g., trains, nuclear plants, etc.) in 

advance of the quake. This helps prevent more severe 

consequences, such as train derailments or nuclear plant 

malfunctions. 

 Improved Emergency Response: Emergency 

services can be better prepared to respond in the 

immediate aftermath of an earthquake. Knowing where 

the earthquake is centered and its magnitude can help 

direct resources to the most affected areas. 

 Psychological Preparedness: Early warning 

systems help communities feel more prepared and less 

anxious about earthquakes, knowing that there is a 

safety net in place. This can lead to better overall 

resilience and quicker recovery in the aftermath. 

 

Supporting Research and Preparedness: Continuous 

monitoring of seismic activity provides valuable data 

for researchers, improving our understanding of 

earthquakes and helping to refine building codes and 

disaster preparedness plans over time. 

1.3 Overview of Earthquake Detection Methods 

1.3.1 Seismometers (Seismic Sensors) 

Seismometers are the primary tools used for detecting 

earthquakes. They measure ground motion  

caused by seismic waves. These instruments can detect 

even tiny movements and are often placed in arrays to 

monitor a wide region. 

1.3.2 Seismic Networks 

A network of seismometers is often set up in 

earthquake-prone areas to detect and track seismic 

activity. These networks consist of hundreds or even 

thousands of sensors strategically placed on the ground 

and sometimes underwater. 

1.3.3 Earthquake Early Warning Systems (EEWS) 

EEWS use real-time data from seismic sensors to detect 

the initial seismic waves (P-waves) that travel faster 

than the more destructive shock waves (S-waves). 

These systems can issue warnings seconds to minutes 

before the damaging waves arrive. 

1.4 Earthquake causes damages to lives and 

property 

  

 An earthquake is an unpredictable natural 

phenomenon which happens suddenly and cannot stop 

it but can be alerted from it. Here Accelerometer 

ADXL335 is used which is highly sensitive to detect 

the pre-earthquake vibrations. It is highly sensitive to 

shakes and vibrations along all the three axes. 

Accelerometer after sensing the vibration converts them 

in to equivalent ADC values. Then these values are read 

by Arduino and shown over the 16x2 LCD. First 

calibrate the Accelerometer by taking the samples of 

surrounding vibrations whenever Arduino Powers up. 

Then need to subtract those sample values from the 

actual readings to get the real readings hence it will not 

show alerts with respect to its normal surrounding 

vibrations. After real readings are found, Arduino 

compares these values with predefined max and min 

values. If Arduino finds any changes from the 

predefined values of any axis in both direction 

(negative and positive) then Arduino trigger the buzzer 

and shows the status of alert over the 16x2 LCD and 

also LED also turned on as well. Sensitivity of the 

earthquake detector can be adjusted changing the 

predefined values in Arduino code. Using GSM 

module, the SMS alert message is sent to the respective 

registered mobile number. Also, two other sensors are 

used, for detecting fire and any gas leakage in the 

building can be sensed using flame and gas sensor 

respectively. If detected SMS alert is sent to the 

corresponding registered mobile numbers. 

1.5 Significant catastrophic events include 

earthquakes:  

  

 The rapid arrival of energy in the Earth's 

interior is causing earthquakes, which most usually 

manifest as rocks exploding after being subjected to 

stresses that exceed their flexible breaking point. When 

two of the earth's outer layers rub up against one 

another, an earthquake is caused. As a result, the 

quake's odd position and prognosis for various places 

may help to lessen the havoc that it caused due to the 

tremors. In this research, a sensitive vibrator that can 

detect vibrations and a small regulator Arduino Mega is 

used to create a quake pointer. Vibrators are quite 

susceptible to earthquakes. The simple voltage 

produced by vibrators is identical to a forced speed 

increase. Any vibration caused by a change is detected 

by the vibrator, which then notifies the miniature 

regulator. The vibrator is connected to the Arduino 

Uber Simple to Advanced Convertor (ADC) pins. A 

light, which serves as both a warning and an indicator 

of seismic tremor, appears when elements in the center 

of a tremor are large enough to pass a value known as 

edge esteem. Although the alert can be used for modern 

purposes, it can also be used for family rules. The LCD 

has been added as a device for advising caution, making 



 

 

733                                                        JNAO Vol. 16, Issue. 1:  2025 

 

the framework effective and simple to use. 

2.  Literature Study 

R. Singh et al. (2016) designed an earthquake detection 

system using the Arduino Mega with a GSM module 

and an ADXL345 accelerometer. Their system could 

detect tremors and send SMS alerts to users. 

 

A. Verma & S. Sharma (2018) implemented an Arduino 

Uno-based system using the MPU6050 sensor. It 

processed acceleration data to determine seismic 

activity and activated alarms for alerting. 

 

P. Ghosh et al. (2019) worked on a wireless earthquake 

monitoring network using Arduino and RF modules. 

The focus was on decentralizing the system for a larger 

geographical area. 

2.1 objectives: 

Arduino-based earthquake detection systems 

are a promising alternative for areas lacking access to 

advanced seismic equipment. While they are not 

replacements for professional-grade systems, they 

provide valuable educational, research, and localized 

warning capabilities. Ongoing research aims to improve 

sensor accuracy, data filtering, and networked detection 

for more reliable performance. 

 

3. Embedded System 

3.1 Embedded System 

An Embedded System is a combination of computer 

hardware and software, and perhaps additional 

mechanical or other parts, designed to perform a 

specific function. An embedded system is a 

microcontroller-based, software driven, reliable, real-

time control system, autonomous, or human or network 

interactive, operating on diverse physical variables and 

in diverse environments and sold into a competitive and 

cost-conscious market. 

 An embedded system is not a computer system 

that is used primarily for processing, not a software 

system on PC or UNIX, not a traditional business or 

scientific application. High-end embedded & lower end 

embedded systems. High-end embedded system - 

Generally 32, 64 Bit Controllers used with OS. 

Examples Personal Digital Assistant and Mobile phones 

etc. Lower end embedded systems - Generally 8,16 Bit 

Controllers used with a minimal operating systems and 

hardware layout designed for the specific purpose. 

 

Fig 3.1 Basic Embedded System 

3.2Embedded System Design Cycle: 

 The embedded system design cycle refers 

to the step-by-step process involved in designing 

an embedded system, which is a computer system 

with a dedicated function embedded within a larger 

device. This cycle covers everything from initial 

concept and specification to design, testing, and 

deployment. It is crucial to ensure the system 

meets the specific requirements of performance, 

reliability, and cost. 

 

 

  Fig 3.2. V 

Diagram 

 

3.3 Characteristics of Embedded System: 

  An embedded system is any computer system 

hidden inside a product other than a computer. They 

will encounter a number of difficulties when writing 

embedded system software in addition to of data in a 

short period of time. Response–Our system may need 

to react to events quickly. Testability–Setting up 

equipment to test embedded software can be difficult. 

Debugability–Without a screen or a keyboard, finding 

out what the software is doing wrong (other than not 

working) is a troublesome problem. Reliability – 

embedded systems must be able to handle any 

situation without human intervention.             

                           Memory space – Memory is 

limited on embedded systems, and you must make 

the software and the data fit into whatever memory 

exists. Program installation – you will need special 

tools to get your software into embedded systems. 

Power consumption – Portable systems must run 

on battery power, and the software in these systems 

must conserve power. Processor hogs – computing 

that requires large amounts of CPU time can 

complicate the response problem. Cost – Reducing 

the cost of the hardware is a concern in many 

embedded system projects; software often operates 

on hardware that is barely adequate for the job. 

Embedded systems have a microprocessor/ 
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microcontroller and a memory.  Some have a serial 

port or a network connection.  They usually do not 

have keyboards, screens or disk drives. 

 
4. Experimental Methodology: 

4.1 Introduction 

4.1.1 Proposed System: - 

 The proposed system is a warning and alert 

system to monitor efficiently earthquake areas in 

real time basis. The system even detects an 

earthquake by using a vibration sensor and provide 

alert to authorities through GSM. A siren is used 

in this system to alert surrounding people when 

earth quake detected. 

 

 

Fig 4.1 Block Diagram 

4.2 Hardware Requirements: - 

• ARDUINO UNO 

• POWER SUPPLY 

• GPS MODULE 

• GSM MODEM 

• BUZZER  

• LCD 

  4.3 Software Requirements: - 

• LANGUAGE: EMBEDDED C 

• SOFTWARE: ARDUINO IDE 

4.4 Working Principle: - 

The system works by continuously monitoring 

vibrations through an accelerometer. When movement 

exceeds a predefined threshold, the Arduino triggers an 

alarm, displays an alert, and (if included) sends a 

notification. 

4.5 Methodology: - 

4.5.1 Sensor Selection & Calibration: 

Use an accelerometer (such as MPU6050) to measure 

changes in X, Y, and Z axes. Calibrate the sensor to 

ensure it accurately detects normal vibrations versus 

earthquake-induced tremors. 

 

 
Fig 4.2 ARDUINO UNO 

4.5.2 Writing and Uploading the Arduino Code: 

• Read accelerometer values using Arduino 

code. 

• Set a threshold value for earthquake detection 

based on sensor readings. 

If the threshold is exceeded: 

• Activate buzzer and LED. 

• Display intensity on the LCD. 

• Send an alert (if GSM module is used). 

• Upload the code using the Arduino IDE and 

test. 

4.5.3 Testing and Validation: 

• Simulate different vibration levels to verify 

system accuracy. 

• Adjust the sensitivity by modifying the 

threshold value. 

• Cross-check readings with actual seismic data 

if available. 

5. Hardware Description 

5.1 Arduino Uno Board: 

Arduino is a single-board microcontroller meant to 

make the application more accessible which are 

interactive objects and its surroundings. The hardware 

features with an open-source hardware board designed 

around an 8-bit Atmel AVR microcontroller or a 32-bit 

Atmel ARM. Current models consists a USB interface, 

6 analog input pins and 14 digital I/O pins that allows 

the user to attach various extension boards. 

 The Arduino Uno board is a microcontroller 

based on the ATmega328. It has 14 digital input/output 

pins in which 6 can be used as PWM outputs, a 16 MHz 

ceramic resonator, an ICSP header, a USB connection, 

6 analog inputs, a power jack and a reset button. This 

contains all the required support needed for 

microcontroller. In order to get started, they are simply 

connected to a computer with a USB cable or with a 

AC-to-DC adapter or battery. Arduino Uno Board 

varies from all other boards and they will not use the 

FTDI USB-to-serial driver chip in them. It is featured 

by the Atmega16U2 (Atmega8U2 up to version R2) 

programmed as a USB-to-serial converter. 
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Fig 5.1 ARDUINO UNO BOARD 

 

 

 
Fig 5.2 Arduino Uno Digital Input/Output 

There are various types of Arduino boards in which 

many of them were third-party compatible versions. 

The most official versions available are the Arduino 

Uno R3 and the Arduino Nano V3. Both of these run a 

16MHz Atmel ATmega328P 8-bit microcontroller with 

32KB of flash RAM 14 digital I/O and six analogue I/O 

and the 32KB will not sound like as if running 

Windows. Arduino projects can be stand-alone or they 

can communicate with software on running on a 

computer. For e.g. Flash, Processing, Max/MSP). The 

board is clocked by a 16 MHz ceramic resonator and 

has a USB connection for power and communication. 

You can easily add micro-SD/SD card storage for 

bigger tasks. 

5.1.2 Features of the Arduino Uno Board: 

• It is an easy USB interface. This allows 

interface with USB as this is like a serial 

device. 

• The chip on the board plugs straight into your 

USB port and supports on your computer as a 

virtual serial port. The benefit of this setup is 

that serial communication is an extremely easy 

protocol which is time-tested and USB makes 

connection with modern computers and makes 

it comfortable. 

5.2 Power Supply: 

5.2.1 Power Supply block Diagram: 

Many electronic circuits need a direct current 

(DC) voltage source, but what we commonly find 

are voltage sources of alternating current (AC). In 

order to achieve a direct current voltage source, the 

alternating current input must follow a conversion 

process like the one shown in the power supply 

block diagram below the image shows the main 

components of a basic power supply diagram and the 

waveforms at the beginning (AC input), at the end 

(DC output) and between blocks. 

 
Fig 5.3Power Supply Circuit Diagram 

5.3 GSM Module – SIM900: 

 

This is a GSM/GPRS-compatible Quad-band 

cell phone, which works on a frequency of 

850/900/1800/1900MHz and which can be used not only 

to access the Internet, but also for oral communication 

(provided that it is connected to a microphone and a 

small loud speaker) and for SMSs. Externally, it looks 

like a big package (0.94 inches x 0.94 inches x 0.12 

inches) with L-shaped contacts on four sides so that they 

can be soldered both on the side and at the bottom. 

Internally, the module is managed by an AMR926EJ-S 

processor, which controls phone communication, data 

communication (through an integrated TCP/IP stack), 

and (through an UART and a TTL serial interface) the 

communication with the circuit interfaced with the cell 

phone itself. 

The processor is also in charge of a SIM card (3 or 1,8 

V) which needs to be attached to the outer wall of the 

module. 

In addition, the GSM900 device integrates an analog 

interface, an  A/D converter, an RTC, an  SPI bus, an 

I²C, and a PWM module. The radio section is GSM 

phase 2/2+ compatible and is either class   4 (2 W) at 

850/ 900 MHz or class 1 (1 W) at 1800/1900 MHz. 

The TTL serial interface is in charge not only 

ofcommunicating all the data relative to the 

SMSalreadyreceived and those that come in during 

TCP/IP sessions in GPRS (the data-rate is determined by 

GPRS class 10: max. 85,6 kbps), but also of receiving 

the circuit commands (in our case, coming from the PIC 

governing the remote control) that can be either AT 

standard or AT-enhancedSIMComtype.The module is 

supplied with continuous energy (between 3.4 and 4.5 

V) and absorbs a maximum of 0.8 A during 

transmission. 
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Fig 5.18 GSM 

Fig 5.19 GSM PINOUT SIM 900 

6. Software Description 

1. Download and install Arduino IDE 

(https://www.arduino.cc/en/Main/Software)  

2. Plug in your Arduino Board  

3. Select the proper board in the IDE 

(Tools>Boards>Arduino Uno)  

4. Select the proper COM port (Tools>Port>COMx 

(Arduino Uno))  

5. Open the “Blink” sketch 

(File>Examples>Basics>01.Blink)  

6. Press the Upload button to upload the program to the 

board  

7. Confirm that your board is working as expected by 

observing LED 

6.1 Troubleshooting Uploading Errors:  

 Arduino has lots of community support and 

documentation. Your best bet when running into 

unexpected problems is to search online for help. You 

should be able to find a forum where someone had the 

same problem you are having, and someone helped 

them fix it. If you don’t find results, try modifying your 

search, or post on the Arduino forums. 

● My board isn’t listed under devices and is not 

recognized by IDE:  

○ Most likely, this means that the ATMega328p chip is 

not programmed with the Arduino firmware. If you 

have a separate working Uno available, you can 

program the unprogrammed chip using this guide and a 

few jumper cables: 

https://www.arduino.cc/en/Tutorial/ArduinoISP 

○ If you don’t have a separate Arduino available, let me 

know and I can use an Atmel Programmer to upload the 

firmware. 

 ○ There may be hardware damage if you had the board 

plugged into USB and external power at the same time. 

You may have to replace the chip if this is the case. 

● Error Message: avrdude: stk500_recv (): programmer 

is not responding  

○ Double-check that you are using the correct COM 

port. 

 ○ Make sure that your Arduino Board is plugged into 

the computer. 

● The IDE says “Uploading…” after pressing the 

upload button, but nothing is happening.  

○ Double-check that you have the correct board 

selected in the Tools menu. 

○ Depending on the size of your program, it may take a 

few seconds to upload. If you feel like it is taking too 

long, it may be encountering an error and you can try 

unplugging and plugging in the Arduino board. 

7. Results: 

7.1 Results from the Earthquake Detector Project: 

 

1. Detection of Ground Movements: The sensor 

will pick up small vibrations or movements in 

the ground. For low-intensity movements, such 

as nearby traffic or walking, the sensor might 

show minor fluctuations, which can be filtered 

out by setting a threshold value in the code. 

2. Threshold Breach: When an earthquake (or 

significant ground shaking) occurs, the sensor 

will detect a sharp spike in the acceleration 

data. If the measured value crosses the 

predefined threshold, the system triggers an 

alert. This threshold is calibrated based on the 

expected seismic activity level that you're 

testing for. 

3. Alert Mechanism: The Arduino may activate a 

buzzer or LED to signal an earthquake. The 

buzzer will make noise, or the LED will blink 

to indicate that a significant seismic event has 

been detected. 

4. Data Logging (Optional): Depending on the 

project design, the Arduino can send the 

seismic data to a computer or server for logging 

and analysis. This could help in understanding 

the intensity and frequency of vibrations over 

time. 

5. Testing and Calibration: During the testing 

phase, the system will be subjected to various 

types of ground vibrations to ensure it responds 

only to real seismic events and ignores false 

positives (like wind or human-induced 

vibrations). You might calibrate the system to 

differentiate between different levels of 

vibrations based on intensity. 

6. User Interface: If an LCD or serial monitor is 

used, the intensity of the detected movement 

can be displayed in real-time, showing data 

such as: 

o Acceleration in X, Y, and Z axes 

o Earthquake detection status 

o Seismic event strength 

https://www.arduino.cc/en/Main/Software
https://www.arduino.cc/en/Tutorial/ArduinoISP
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7. Power and Efficiency: The Arduino system can 

be powered via USB or batteries, and power 

consumption will depend on the setup. For 

portability, a low-power design would be ideal, 

especially if used for long periods or in remote 

locations. 

7.2 Observations: 

 

• Seismic Movement Detection: The system 

should show significant changes when real 

earthquakes or vibrations occur. Minor 

movements from objects (like walking) should 

not trigger false alarms if the threshold is set 

appropriately. 

• Alert Activation: The buzzer or LED should 

activate when the system detects a vibration 

that exceeds the threshold, indicating an 

earthquake or strong ground movement. 

• Real-Time Feedback: You will see data 

displayed in real-time, which can help you 

evaluate the system's sensitivity to different 

levels of ground movement. 

• Threshold Calibration: You may need to adjust 

the threshold for sensitivity based on testing in 

different environments to avoid false positives 

or missed detections. 

 This type of project provides a basic, entry-

level approach to earthquake detection, and it's a good 

way to learn about sensors, Arduino programming, and 

data processing. However, keep in mind that real-world 

earthquake detection requires much more sophisticated 

equipment, algorithms, and large-scale sensor networks. 

8. Conclusion 

 
 

Early detection can ensure easy evacuation. Creating 

awareness can lead to make possible preventive 

measures so that a huge disaster can be avoided. 

Optimal size makes the system easier to handle. The 

future work involves improving our system's sensor 

accuracy and better scaling calculation, also improving 

our device portability, and therefore system can be 

attached to various suitable places inside the building.  

 In conclusion, the earthquake detection system 

using Arduino proves to be an effective and accessible 

solution for early earthquake detection. By utilizing 

simple yet reliable components such as accelerometers, 

sensors, and Arduino boards, the system can detect 

seismic movements in real time. The project provides a 

cost-effective way to monitor ground motion, offering 

early warning alerts to mitigate potential damage and 

enhance safety. 

  This system is particularly beneficial in 

regions prone to earthquakes, where early detection can 

save lives, reduce property damage, and assist in 

emergency response efforts. With the growing 

importance of disaster preparedness, this Arduino-based 

earthquake detection project serves as a valuable 

prototype for more advanced systems. 

  Future improvements could include 

enhancing the system's accuracy by integrating more 

sophisticated sensors, adding communication features 

like SMS or Wi-Fi for real-time alerts, and expanding 

the system's range and sensitivity. Additionally, 

integrating machine learning algorithms to distinguish 

between earthquake-induced vibrations and other 

sources of ground movement could further improve the 

system's performance. 
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